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1 Features

1.1 Supported Diagrams
Software Ideas Modeler supports 22 types of diagrams, which involves all 14 types of UML diagrams
and 8 others.

1.1.1 UML diagrams
Software Ideas Modelers supports all 14 types of UML (Unified Modeling Language) diagrams defined
in UML 2.x specification.

Structure diagrams:
e C(Class Diagram
e Composite Structure Diagram
* Component Diagram
¢ Deployment Diagram
e Object Diagram
e Package Diagram
e  Profile Diagram
Behavior diagrams:
* Activity Diagram
e Use Case Diagram
e State Machine Diagram
* Interaction Diagram:
o Sequence Diagram
o Communication Diagram
o Interaction Overview Diagram
o Timing Diagram
1.1.1.1 Class Diagram

Class diagram describes the structure of a system by showing the system's classes, their attributes,
and the relationships among the classes.
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1.1.1.2 Composite Structure Diagram
Composite structure diagram describes the internal structure of a class and the collaborations that
this structure makes possible.

1.1.1.3 Component Diagram
Component diagram describes how a software system is split up into high level components and
shows the dependencies among these components. This type of diagram is suitable for depicting a
structure of complex systems.

1.1.1.4 Deployment Diagram
Deployment diagram describes the hardware used in system implementations and the execution
environments and artifacts deployed on the hardware.

1.1.1.5 Object Diagram
Object diagram shows a complete or partial view of the structure of a modeled system at a specific
time.

1.1.1.6 Package Diagram
Package diagram describes logical groups of model elements and shows the dependencies among
these groups.

1.1.1.7 Activity Diagram
Activity diagram describes the high-level business processes and workflows of components in a
system. It allows modeling the complex logic within a system, shows the overall control flow.

1.1.1.8 Use Case Diagram
Use case diagram describes the overall functionality of a system in terms of actors, their goals
represented as use cases, and any dependencies among those use cases.

1.1.1.9 State Machine Diagram
State machine diagram specifies the states and describes transitions between states of the system.

1.1.1.10 Sequence Diagram
Sequence diagram shows how objects communicate with one another and in what order in terms of
a sequence of messages.

1.1.1.11 Communication Diagram

Communication diagram shows the interactions between objects or parts in terms of sequenced
messages. They represent a combination of information taken from Class, Sequence, and Use Case
Diagrams describing both the static structure and dynamic behavior of a system.
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1.1.1.12 Interaction Overview Diagram
Interaction overview diagram provides an overview in which the nodes represent interaction
diagrams and shows the control flow among those diagrams.

1.1.1.13 Timing Diagram
Timing diagram is a specific type of interaction diagram where the focus is on timing constraints.

1.1.2 Other diagrams
Except UML diagrams Software ldeas Modeler supports also many other types of diagrams:
* Mixed Diagram
* Robustness Diagram
e Entity Relationship Diagram
*  Flowchart Diagram
e Data Flow Diagram
* Requirement Diagram
e User Interface Diagram
e CRC Card Diagram

1.1.2.1 Mixed Diagram
Mixed diagram allows combining of all UML elements in one diagram.

1.1.2.2 Robustness Diagram

Robustness diagram is a simplified form of communication diagram, which allows depict the
concepts as Actors, Boundary elements, Control elements, Entity elements and optionally also Use
cases.

1.1.2.3 Entity Relationship Diagram
Entity relationship diagram shows an abstract and conceptual representation of data. It is mainly
used for database modeling.

1.1.2.4 Flowchart Diagram
Flowchart diagram allows depicting an algorithm or process, showing the steps as boxes of various
kinds, and their order by connecting these with arrows.

1.1.2.5 Data Flow Diagram

Data flow diagram is a type of diagram, which represent the flow of data through an information
system. Data flow diagram can also be used for structured design — the visualization of data
processing.
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1.1.2.6 Requirement Diagram
Requirement diagram allows to graphically organize, manage, and trace requirements.

1.1.2.7 User Interface Diagram
User interface diagram can be used to fast prototyping of user interfaces, its modeling and

specification.

1.1.2.8 CRC Card Diagram

Class Responsibility Collaboration (CRC) cards are a brainstorming tool used in the design of object-
oriented software. The main purpose is to identify and specify which classes are needed and how
they interact.
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2 Installation

Software Ideas Modeler needs for its run installed .NET Framework 3.5.

2.1 Windows 7
If you have Windows 7, you needn't install anything. Windows 7 has preinstalled .NET Framework
3.5.1.

2.2 Windows Vista and older versions
If you use Windows Vista or one of previous versions, you must install .NET Framework 3.5. You can
download it from Microsoft's site: .NET Framework 3.5 Setup

2.3 Linux

If you want to run Software Ideas Modeler under Linux, use the ZIP Package version in download
section. Mono is required to be installed. You need also the package libmono-winforms2.0-cil.
Software Ideas Modeler can be run using the command "mono /
[PathToExecutableFile]/SoftwareldeasModeler.exe".
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3 Menus

3.1 File
The file menu contains the main actions, which allows you to start work and later to save the result
of your work or creates the other output using print/export actions.

3.1.1 New

Shortcut keys: Ctrl + N

Creates new file. If the current window is empty (no project is open), it is used for the new project. If
the current window contains a project, the new window with empty project is open.

3.1.2 Open

Shortcut keys: Ctrl + O

Opens a file (chosen in the open dialog) for editing. If the current window is empty (no project is
open), it is used for opening the chosen project. If the current window contains a project, the new
window is open.

3.1.3 Save

Shortcut keys: Ctrl + S

Saves the open project with all its contents. If you use the save for the first time, it will work the
same way as Save As.

3.1.4 Save as

Shortcut keys: -

Saves the open project with all its contents in another file chosen in the save dialog.

3.1.5 Close Project

Shortcut keys: -

Closes the current project, but do not close the current window.

3.1.6 Export

Shortcut keys: -

Shows submenu with commands, which export the current project to another non-native formats.

3.1.7 Export /Image
Shortcut keys: -
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Launches the Batch export dialog, which allows you to export the chosen diagrams of the current
project to images.

3.1.8 Export /XMl

Shortcut keys: -

Exports the current project to XMI (XML Metadata Interchange) format.
3.1.9 Import

Shortcut keys: -

Imports non-native formats into the current project.

3.1.10 Import / XMI

Shortcut keys: -

Imports the UML elements from XMl file chosen in the open file dialog.
3.1.11 Print

Shortcut keys: Ctrl + P

Launches Print dialog, where you can select the diagrams you want to print. You can also set the
print settings and see the print preview before you start printing.
3.1.12 Recent Project

Shortcut keys: -

Shows the submenu with list of recent projects.

3.1.12.1 (List of recent projects)

List consists of recently open, saved projects. If you wait for a while with mouse cursor over the
menu item with name of project, the tooltip with full path to the project will be shown.

3.1.12.2 Clear this list

Shortcut keys: -

Irreversibly clears the list of recent projects.
3.1.13 Exit

Shortcut keys: Alt + F4

Closes the current window.

3.2 Edit

The edit menu allows you manipulate elements in the editor area.
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3.2.1.1 Undo
Shortcut keys: Ctrl +Z

This command reverses your last editing action. The default number of steps you can undo is 500.
3.2.1.2 Redo

Shortcut keys: Ctrl +Y

This command applies again the editing action, which has been recently reversed by the Undo
command.

3.2.1.3 Cut

Shortcut keys: Ctrl + X

This command removes the selected elements and places them in the clipboard.
3.2.1.4 Copy

Shortcut keys: Ctrl + C

This command copies the selected elements in the clipboard.

3.2.1.5 Paste

Shortcut keys: Ctrl + V

This command places elements from clipboard in the current diagram.

3.2.1.6 Delete

Shortcut keys: Del

This command removes the selected elements from diagram (not from project).
3.2.1.7 Delete with Relations

Shortcut keys: Ctrl + Del

This command removes the selected elements together with associated relations.
3.2.1.8 Select All

Shortcut keys: Ctrl + A

This command selects all elements in the current diagram.

3.2.1.9 Select All of Same Type

Shortcut keys: Ctrl + T

This command selects all elements in the current diagram, which have the same type as an already
selected element.
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3.2.1.10 Invert Selection
Shortcut keys: -

This command inverts the selection — deselects the selected elements and selects the elements
which were not selected.
3.2.1.11 Find

Shortcut keys: Ctrl + F

This command shows the Find dialog, which allows you to search the text in the all diagrams in the
current project.

3.3 View

The View menu allows you to set custom preferences for user interface of Software Ideas Modeler.
3.3.1 Standard Bar
Shortcut keys: -

Shows/hides the standard bar.
3.3.2 Layout Bar

Shortcut keys:-

Shows/hides the layout bar.
3.3.3 Status Bar

Shortcut keys: -

Shows/hides the status bar.
3.3.4 Toolbox

Shortcut keys: -

Shows/hides the toolbox.
3.3.5 Side Bar

Shortcut keys: -

Shows/hides the side bar.
3.3.6 Diagram Preview
Shortcut keys: -

Shows/hides the diagram preview panel.
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3.3.7 Start Page
Shortcut keys: -

Opens or (if it is already open) navigates to Start Page window.

3.3.8 Element Browser

Shortcut keys: Ctrl + Shift + E

Opens or (if it is already open) navigates to Element Browser window.
3.3.9 Show Assigned Diagrams

Shortcut keys: -

This command turns on/off displaying of icon, which indicates whether an element has assigned one
or more diagrams. The icon is depicted on Figure 1.

)

Class

Figure 1. Element with assigned diagrams
3.3.10 Show Multiple Usage of Element
Shortcut keys: -

This command turns on/off displaying of icon, which indicates whether an element has been used in
more than one diagram. The icon is depicted on Figure 2.

Class

Figure 2. Element which is used in more than one diagram

3.3.11 Grid
Shortcut keys: Alt + G

This command turns on/off the grid in the diagram editor. It is independent from snapping to grid.
3.3.12 Snap to Grid

Shortcut keys: -

This command turns on/off the snapping to grid. It is independent from displaying the grid.

3.3.13 Rendering Quality

Shortcut keys: -

Shows the submenu with rendering quality options.
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3.3.13.1 Draft
Shortcut keys: -

It sets the worst quality of diagram rendering. It turns off gradients, shadows, effects and anti-
aliasing (for drawings and also for texts).

3.3.13.2 Normal

Shortcut keys: -

It sets the medium quality of diagram rendering. It turns off smooth shadows (all shadows are
rendered as flat) and effects.

3.3.13.3 Best

Shortcut keys: -

It sets the best quality of diagram rendering. The graphics is rendered in best possible quality.

3.3.14 Full Screen

Shortcut keys: F12

Switches from normal mode to full screen mode or vice versa. The full screen mode provides the
biggest space for the diagram editor area.

3.4 Project
The Project menu has the commands to work with its structure and contents.

3.4.1 Add Model

Shortcut keys: Ctrl + M

This command appends a new model in the top level of the current project.

3.4.2 Add Diagram

Shortcut keys: -

Shows a submenu with list of diagram types. The new diagram of type chosen from this submenu
appends to the current active model selected in the project tree.

3.4.2.1 New Diagram

Shortcut keys: Ctrl + Shift + D

Shows a New Diagram dialog (Figure 3) where you can set the name of new diagram and choose its
type. After confirming the dialog clicking on OK button, the new diagram will be appended to the
current active model.
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-
New Diagram

Select the type of diagram you wart to add to the project:

UML Diagrams =
Use Case Diagram Class Diagram Package Diagram Object Diagram Component Diagram
EEI i é@l "
Composite Structure  Sequence Diagram Communication Activity Diagram State Machine
Diagram Diagram Diagram
Interaction Overview Deployment Diagram Timing Diagram Profile Diagram
Diagram -

Name:

Figure 3. New Diagram dialog

3.4.2.2 Class Diagram
Shortcut keys: -

Appends a new class diagram to the current active model.
3.4.2.3 Object Diagram

Shortcut keys: -

Appends a new object diagram to the current active model.
3.4.2.4 Package Diagram

Shortcut keys: -

Appends a new package diagram to the current active model.
3.4.2.5 Use Case Diagram

Shortcut keys: -

Appends a new use case diagram to the current active model.
3.4.2.6 Composite Structure Diagram

Shortcut keys: -

Appends a new composite structure diagram to the current active model.
3.4.2.7 Component Diagram

Shortcut keys: -

Appends a new component diagram to the current active model.
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3.4.2.8 Activity Diagram
Shortcut keys: -

Appends a new activity diagram to the current active model.
3.4.2.9 State Machine Diagram

Shortcut keys: -

Appends a new state machine diagram to the current active model.
3.4.2.10 Sequence Diagram

Shortcut keys: -

Appends a new sequence diagram to the current active model.
3.4.2.11 Communication Diagram

Shortcut keys: -

Appends a new communication diagram to the current active model.
3.4.2.12 Interaction Overview Diagram

Shortcut keys: -

Appends a new interaction overview diagram to the current active model.
3.4.2.13 Deployment Diagram

Shortcut keys: -

Appends a new deployment diagram to the current active model.
3.4.2.14 Timing Diagram

Shortcut keys: -

Appends a new timing diagram to the current active model.
3.4.2.15 Profile Diagram

Shortcut keys: -

Appends a new profile diagram to the current active model.
3.4.2.16 Mixed Diagram

Shortcut keys: -

Appends a new mixed diagram to the current active model.

3.4.2.17 Robustness Diagram
Shortcut keys: -
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Appends a new robustness diagram to the current active model.
3.4.2.18 Entity Relationship Diagram

Shortcut keys: -

Appends a new entity relationship diagram to the current active model.
3.4.2.19 Flowchart Diagram

Shortcut keys: -

Appends a new flowchart diagram to the current active model.
3.4.2.20 Data Flow Diagram

Shortcut keys: -

Appends a new data flow diagram to the current active model.
3.4.2.21 Requirement Diagram

Shortcut keys: -

Appends a new requirement diagram to the current active model.
3.4.2.22 User Interface

Shortcut keys: -

Appends a new user interface diagram to the current active model.
3.4.2.23 CRC Card Diagram

Shortcut keys: -

Appends a new CRC Card diagram to the current active model.
3.4.3 Add Existing Diagram

Shortcut keys: -

Shows an open file dialog, where you select a project file, from which you want to copy existing
diagram(s). Then the Add Existing Diagram dialog (Figure 4) will be shown, where you can choose the
diagrams you want to add to the current active model of the current open project.
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Add Existing Diagram u

=-[C] Project (Project)
= Model 1 (Madel)

Figure 4. Add Existing Diagram dialog

3.4.4 Project Properties
Shortcut keys: -

Opens or (if it is already open) navigates to Project Properties window, where you can set the name,
authors and description of the current project.
3.4.5 Model Properties

Shortcut keys: -

Shows the Model Properties dialog for the current active model. This dialog allows you to set the
name of model, the custom namespace (otherwise the default name for namespace is used) and
documentation.

3.4.6 Style Set

Shortcut keys: -

Shows the submenu with commands for style sets.
3.4.6.1 Default

Shortcut keys: -

Sets the default style set for the current project.

3.4.6.2 (List of style sets)
The menu contains the list of available style sets.

3.4.6.3 Load
Shortcut keys: -

Loads a style set from the selected file in the open file dialog.
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3.4.6.4 Save
Shortcut keys: -

Saves the current style set.

3.4.6.5 Edit

Shortcut keys: -

Shows the dialog for editing the current style set.

3.4.6.6 Remove All Custom Styles

Shortcut keys: -

Removes the custom styles from all elements in the current project. The default style defined in the
current style set is used instead of the other custom styles defined for individual elements.

3.4.7 Tasks

Shortcut keys: Ctrl + Alt + T

Opens or (if it is already open) navigates to Task Management window, where you can manage the
tasks associated with the current project.

3.4.8 Persons

Shortcut keys: Ctrl + Alt + P

Opens or (if it is already open) navigates to Persons window, where you can edit the list of persons
associated with the current project.

3.5 Diagram
The Diagram menu allows you to perform actions on the current active diagram.

3.5.1 Add Layer

Shortcut keys: -

Adds new layer in the current active diagram.
3.5.2 Layers

Shortcut keys: -

Shows the submenu with commands for layers.
3.5.2.1 Merge

Shortcut keys: Ctrl + Shift + Down

Merges all layers of the current active diagram in the single one.
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3.5.2.2 Show All
Shortcut keys: -

Sets all layers to be visible.
3.5.2.3 Hide

Shortcut keys: -

Hides the current active layer.
3.5.2.4 Delete

Shortcut keys: -

Deletes the current active layer.
3.5.2.5 (List of layers)

The menu contains the list of all layers present in the current active diagram. The active layer is
checked. When you click on the layer menu item, you set it active.

3.5.3 ConvertTo
Shortcut keys: -

Shows submenu with commands to convert the current diagram to another diagram type.

3.5.3.1 Entity Relationship Diagram
Shortcut keys: -

This command converts the current active UML class diagram to entity relationship diagram. This
conversion can be performed only with UML class diagram.

3.5.3.2 Class Diagram
Shortcut keys: -

This command converts the current active entity relationship diagram to UML class diagram. This
conversion can be performed only with entity relationship diagram.

3.5.4 Diagram Properties
Shortcut keys: -

This command opens the Diagram Properties dialog, which allows you to set the name, custom
namespace, authors, version, description and documentation of the current active diagram. Diagram
Properties dialog contains also the read-only information about creation date and date of last
change.

3.5.5 Print
Shortcut keys: -

This command prints the current active diagram.
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3.5.6 Export
Shortcut keys: -

Shows submenu with commands, which export the current project to another non-native formats.
3.5.6.1 Image

Shortcut keys: -

This command exports the current active diagram to one of supported image formats.

3.5.6.2 PDF

Shortcut keys: -

This command exports the current active diagram to PDF format.

3.5.7 Copy as Image

Shortcut keys: Ctrl + Shift + |

This command copies the current diagram to clipboard as a bitmap.

3.5.8 Copy as Metafile

Shortcut keys: Ctrl + Shift + M

This command copies the current diagram to clipboard as a vector metafile.

3.5.9 Filter

Shortcut keys: -

Shows the submenu with commands, which allow you to filter the content of the current active
diagram.

3.5.9.1 Show All Elements

Shortcut keys: -

This command removes the filter — all elements will be shown.

3.5.9.2 Hide Comments

Shortcut keys: Ctrl + Alt + C

This command applies the filter to current active diagram, which hides all comments also with its
connector lines.

3.5.9.3 Hide Relations

Shortcut keys: -

This command applies the filter to current active diagram, which hides all relations of any type.
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3.5.9.4 Hide Collaborations
Shortcut keys: -

This command applies the filter to current active diagram, which hides the collaboration elements.

3.6 Element
The Diagram menu allows you to perform actions on the selected element.

3.6.1 Add

Shortcut keys: -

Shows the submenu with commands, which allow you to add new parts to the selected element.
3.6.1.1 Attribute

Shortcut keys: Ctrl + Shift + A

This command adds a new attribute to the selected class element.

3.6.1.2 Operation

Shortcut keys: Ctrl + Shift + O

This command adds a new operation to the selected class element.

3.6.1.3 Template Parameter

Shortcut keys: Ctrl + Shift + T

This command adds a new template parameter to the selected class element.
3.6.2 ShowID

Shortcut keys: -

This command shows/hides the ID (Figure 5) of selected element(s).

C001 §Class1

Figure 5. Class with the displayed ID.

3.6.3 Show Parent Name
Shortcut keys: -

This command shows/hides the parent name (Figure 6) of selected element(s).
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Model 1::Class1

Figure 6. Class with the displayed parent name

3.6.4 Show Stereotypes
Shortcut keys: -

This command shows/hides stereotypes (Figure 7) of selected element(s).

alnterfaces
aCUSIOM s
ass

Figure 7. Class with displayed stereotypes

3.6.5 Show Template Parameters
Shortcut keys: -

This command shows/hides template parameters Figure 7(Figure 8) of selected element(s).

TemplateParameteri |
TemplateParameter2 :

Figure 8. Class with displayed template paramteters

3.6.6 Show Attributes
Shortcut keys: -

This command shows/hides attributes of selected element(s).

3.6.7 Show Operations
Shortcut keys: -

This command shows/hides operations of selected element(s).
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3.6.8 Show Operation Parameters
Shortcut keys: -

This command shows/hides parameters of operations (Figure 9) of selected element(s).

Class1

+ MewOperation1 (...
+ MewOperation2 (...

Figure 9. Class with hidden operation parameters

3.6.9 Show Tagged Values
Shortcut keys: -

This command shows/hides tagged values (Figure 10) of selected element(s).

Class1

{Tagf = Value1}
{TagZ = Valuez}

Figure 10. Class with displayed tagged values

3.6.10 Show Relationship Texts
Shortcut keys: -

This command shows/hides texts (Figure 11) of selected relationship(s).

Class1 Class2

0.1 associated with  -class

-class? a

Class1 Class2

Figure 11. Relation with: a) displayed and b) hidden texts
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3.6.11 Show Nullability
Shortcut keys: -

This command shows/hides nullability (Figure 12) of attributes of selected element(s).

| Entity1
Attribute1 - NOT NULL

Figure 12. Entity with the displayed nullability

3.6.12 Show Extension Points
Shortcut keys: -

This command shows/hides extension points (Figure 13Figure 7) of selected Use Case(s).

wextends
(extension1) e UseCase2
UseCase1 e SR
r extension points 1 B
extension it
extension2 SR
wBxtends T~
(extension2) UseCase3

Figure 13. Use case with displayed extension points

3.6.13 Modifiers
Shortcut keys: -

Shows submenu with commands, which allows you to change the modifiers of the selected
element(s).

3.6.13.1 Abstract

Shortcut keys: -

This command sets/unsets abstract modifier to the selected element(s).

3.6.13.2 Private

Shortcut keys: -

This command sets the private visibility to the selected element(s).
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3.6.13.3 Protected
Shortcut keys: -

This command sets the protected visibility to the selected element(s).

3.6.13.4 Package

Shortcut keys: -

This command sets the package visibility to the selected element(s).

3.6.13.5 Public

Shortcut keys: -

This command sets the public visibility to the selected element(s).

3.6.14 Presentation

Shortcut keys: -

Shows submenu with commands, which allows you to change the entire visual of the selected
element.

3.6.14.1 Default

Shortcut keys: -

This command sets the default presentation of the selected element. The element will be rendered
in the default manner.

3.6.14.2 Custom

Shortcut keys: -

This command sets the custom presentation of the selected element. It shows the file open dialog,
where you can choose the image in supported format, which will be used as replacement of the
default visual of the element. The image will be only linked to the project file (if it is possible, the
relative path is used).

3.6.15 Style

Shortcut keys: Alt + S

This command opens the Properties dialog on Style tab. There you can edit the style of the selected
element.

3.6.16 Properties

Shortcut keys: Alt + P

This command opens the Properties dialog on General tab. You can edit all properties of the selected
element in this dialog.
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3.6.17 Documentation
Shortcut keys: Alt + D

This command opens the Properties dialog on Documentation tab. There you can edit the
documentation text of the selected element.

3.6.18 Tagged Values
Shortcut keys: -

This command opens the Properties dialog on Tagged Values tab. There you can edit the tagged
values of the selected element.

3.7 Arrange
The Arrange menu provides commands, which help you to adjust the bounds and alignments of
elements and the whole layout of the diagram.

3.7.1 Auto Layout
Shortcut keys: -

Shows submenu with predefined automatic layouts, which can be applied to the whole active
diagram or to the selection depending on the selection is empty or not.

3.7.1.1 Row Layout
Shortcut keys: -

This command applies the row layout (Figure 14) to the selected elements or to the whole active
diagram, if the selection is empty. Elements are sequentially placed from left to right, from top to
bottom so that the rows of elements are created.

ClassA ClassC ClassD ClassB ClassE ClassF

—
/

ClassG ClassH //

/'/ >

Figure 14. Row layout example

3.7.1.2 Circle Layout
Shortcut keys: -
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This command applies the circle layout (Figure 15) to the selected elements or to the whole active
diagram, if the selection is empty. Elements are sequentially placed on the circumference of a circle.

[T

Figure 15. Circle layout example

3.7.1.3 Cascade Layout
Shortcut keys: Alt + C

This command applies the cascade layout (Figure 16) to the selected elements or to the whole active
diagram, if the selection is empty. Elements are sequentially placed from top left to bottom right in
parallel diagonals.
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Figure 16. Cascade layout example

3.7.1.4 Smart Layout
Shortcut keys: Alt + M

This command applies the smart layout (Figure 17) to the selected elements or to the whole active
diagram, if the selection is empty. Program tries to arrange elements so that the associated elements
are close to each other and there are as few intersections as possible.

ClassH

ClassF ClassB ClassA ClassE

ClassC ClassD

Figure 17. Smart layout example

3.7.2 Auto Size
Shortcut keys: Alt + A
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This command sets the smallest possible size of the selected element(s), which is big enough to be all
parts of the element visible (Figure 18).

Class9

- NewAttribute1 Class9
- NewAttribute2

i - NewAttribute1
+ NewOperation1 () I
+ NewOperation2 () % ;Nrjwﬁ‘;tnbu'fz o
ewOperation
+ NewOperation2 ()

Figure 18. Auto size applying

3.7.3 Route Relation
Shortcut keys: Alt + R

This command adjusts the path of the selected relation to not go through other elements.

3.7.4 Alignment

Shortcut keys: -

Shows the submenu with commands, which allows you to align the selected elements in different
ways.

3.7.4.1 Left

Shortcut keys: -

This command aligns the selected elements to the left border of bounds specified by selected
elements.

3.7.4.2 Right

Shortcut keys: -

This command aligns the selected elements to the right border of bounds specified by selected
elements.

3.74.3 Top

Shortcut keys: -

This command aligns the selected elements to the top border of bounds specified by selected
elements.

3.7.4.4 Bottom

Shortcut keys: -

This command aligns the selected elements to the bottom border of bounds specified by selected
elements.
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3.7.4.5 Center Vertically
Shortcut keys: -

This command aligns the selected elements to be centered to the vertical line, which is placed in the
center of the selection.

3.7.4.6 Center Horizontally

Shortcut keys: -

This command aligns the selected elements to be centered to the horizontal line, which is placed in
the center of the selection.

3.7.5 Make Same

Shortcut keys: -

Shows the submenu with commands, which allow you easily to set the same width, height or both
for all selected elements.

3.7.5.1 Width

Shortcut keys: -

This command set the same width for all selected elements by the first element.

3.7.5.2 Height

Shortcut keys: -

This command set the same height for all selected elements by the first element.

3.7.5.3 Both

Shortcut keys: -

This command set the same width and height for all selected elements by the first element.

3.7.6 Order

Shortcut keys: -

Shows the submenu with commands, which allows you to move the overlapped elements in the z-
order.

3.7.6.1 Bring To Front

Shortcut keys: -

This command moves the selected element(s) to front of all elements in the current active diagram.
3.7.6.2 Send To Back

Shortcut keys: -

This command moves the selected element(s) to back of all elements in the current active diagram.
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3.7.6.3 Forward One
Shortcut keys: -

This command moves the selected element(s) one step forward in the z-order.
3.7.6.4 Back One

Shortcut keys: -

This command moves the selected element(s) one step backward in the z-order.
3.7.7 Move

Shortcut keys: -

Shows the submenu with commands for exact moving of element(s).

3.7.7.1 Custom

Shortcut keys: -

This command shows the Custom Move dialog (Figure 19), where you can set how you want to move
the selected element(s). There are four fields:

e Right — moves the selected element(s) to the right by specified number of pixels.
* Down —moves the selected element(s) down by specified number of pixels.
¢ Left — moves the selected element(s) to the left by specified number of pixels

* Up—moves the selected element(s) up by specified number of pixels.

Custom Move ﬁ
Right: 20
Down: 10
Left: -20
p: -10
oK || Cancsl

Figure 19. Custom Move dialog

3.7.7.2 Left
Shortcut keys: -

This command moves the selected element(s) to the left by 10 pixels.

3.7.7.3 Right
Shortcut keys: -
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This command moves the selected element(s) to the right by 10 pixels.
3.7.7.4 Down

Shortcut keys: -

This command moves the selected element(s) down by 10 pixels.
3.7.7.5 Up

Shortcut keys: -

This command moves the selected element(s) up by 10 pixels.
3.7.8 Size

Shortcut keys: -

Shows the submenu with commands for adjusting the size.
3.7.8.1 Custom

Shortcut keys: -

This command shows the Custom Size dialog (Figure 20), where you can set how you want to change
the size of selected element(s).

Custom 5Size ﬁ
@ General
Inflate: 10
Deflate: -10
71 Sides
Left: h
Right: B
Top: b
Bottom: b
71 Width/height
Width: 10
Height : 10
0K || Cancel

Figure 20. Custom Size dialog

3.7.8.2 Inflate
Shortcut keys: -
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This command inflates the selected element(s) by 10 pixels. The width and height is increased by 10
pixels and the elements are moved so that the center remains in the same place.

3.7.8.3 Deflate

Shortcut keys: -

This command deflates the selected element(s) by 10 pixels. The width and height is decreased by 10
pixels and the elements are moved so that the center remains in the same place.

3.7.8.4 Wider

Shortcut keys: -

This command enlarges the width of the selected element(s) by 10 pixels. The elements are moved
so that the center remains in the same place.

3.7.8.5 Narrower

Shortcut keys: -

This command reduces the width of the selected element(s) by 10 pixels. The elements are moved so
that the center remains in the same place.

3.7.8.6 Higher

Shortcut keys: -

This command enlarges the height of the selected element(s) by 10 pixels. The elements are moved
so that the center remains in the same place.

3.7.8.7 Lower

Shortcut keys: -

This command reduces the height of the selected element(s) by 10 pixels. The elements are moved
so that the center remains in the same place.

3.7.9 Lock Items

Shortcut keys: Ctrl + L

This command locks/unlocks the selected element(s). The locked elements will be not able to move
until you unlock them.

3.7.10 Group ltems

Shortcut keys: Ctrl + G

This command groups the selected element(s) into the single element.

3.7.11 Ungroup Items

Shortcut keys: Ctrl + U

This command ungroups the selected group(s).
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3.8 Tools
The Tools menu provides various special tools. It allows you to generate documentation, source
code, do reverse engineering, edit lists and set options.

3.8.1 Generate Documentation

Shortcut keys: -

This command shows the Generate Documentation dialog, which allows you to generate the
documentation for the current project in PDF or RTF format.

3.8.2 Generate Source Code

Shortcut keys: -

This command shows the Source Code Generation dialog, which allows you to generate the source
codes for the chosen parts of project in the selected programming language.

3.8.3 Lists

Shortcut keys: -

Shows the submenu, which provides commands for editing the lists.

3.8.3.1 Stereotypes

Shortcut keys: -

This command opens the dialog for editing the list of stereotypes.

3.8.3.2 Types

Shortcut keys: -

This command opens the dialog for editing the list of types.

3.8.3.3 Element Names and IDs

Shortcut keys: -

This command opens the dialog for editing the list of default element names and ID patterns.
3.8.4 Renumber Element IDs

Shortcut keys: -

This command opens the dialog, in which you can easily order elements and renumber their IDs.
3.8.5 Reverse Engineering

Shortcut keys: -

Shows the submenu with sources, from which you can perform the reverse engineering.
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3.8.5.1 .NET Framework
Shortcut keys: -

This command shows the dialog for reverse engineering from .NET Framework.

3.8.5.2 Database

Shortcut keys: -

This command shows the dialog for reverse engineering from Database.

3.8.6 Languages

Shortcut keys: -

Shows the submenu with available languages for user interface of Software Ideas Modeler.
3.8.6.1 (List of languages)

List of available languages. When you click on language menu item, the user interface of Software
Ideas Modeler is translated to this chosen language.

3.8.7 Options
Shortcut keys: -

This command shows the Options dialog, in which you can change your user preferences.

3.9 Windows

The Windows menu provides commands which allow you to manipulate the open child window.
3.9.1 Cascade

Shortcut keys: -

This command arranges the open child windows in cascade.
3.9.2 Tile Vertical

Shortcut keys: -

This command arranges the open child windows vertically.
3.9.3 Tile Horizontal

Shortcut keys: -

This command arranges the open child windows horizontally.
3.9.4 Arrange Icons

Shortcut keys: -

This command arranges the headers of minimized child windows.
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3.9.5 Close All
Shortcut keys: -

This command closes all open windows. It does not close the current project.

3.9.6 (List of open windows)
The list of open windows contains names of nine first windows.

3.10 Help

The Help menu provides the access to help and to the information about the product.

3.10.1 Online Help
Shortcut keys: -

This command starts your browser and opens the online help on official website of Software Ideas
Modeler.

3.10.2 Web Site
Shortcut keys: -

This command starts your browser and opens the official website of Software Ideas Modeler.

3.10.3 Activate For Commercial Use
Shortcut keys: -

This command shows the dialog where you can insert your activation code, you received by e-mail
after purchasing the license. If your copy of Software Ideas Modeler is already registered, the
message box is displayed which informs you about it.

3.10.4 Donate
Shortcut keys: -

This command shows the Donor Center dialog, where you can insert your donor key, which you
received by e-mail after sending the donation.

3.10.5 What’s New
Shortcut keys: -

This command shows the dialog with release notes. You can see there what changes are made
between versions.

3.10.6 Check for Updates
Shortcut keys: -

This command allows you to check whether newer version of Software Ideas Modeler is available for

download.
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3.10.7 Send Request
Shortcut keys: -

This command is available only for official supporters (send donation) and for commercial users. It

shows the dialog, from which you can send your request for feature or something else.

3.10.8 About Software Ideas Modeler
Shortcut keys: -

This command displays information about the Software Ideas Modeler and its exact version.
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4 Toolbars

4.1 Standard Bar

4.1.1 New
This command creates new file. If the current window is empty (no project is open), it is used for the
new project. If the current window contains a project, the new window with empty project is open.

4.1.2 Open

This command opens a file (chosen in the open dialog) for editing. If the current window is empty (no
project is open), it is used for opening the chosen project. If the current window contains a project,
the new window is open.

4.1.3 Save
This command saves the open project with all its contents. If you use the save for the first time, it will
work the same way as Save As.

4.1.4 Cut
This command removes the selected elements and places them in the clipboard.

4.1.5 Copy
This command copies the selected elements in the clipboard.

4.1.6 Paste
This command places elements from clipboard in the current diagram.

4.1.7 Undo
This command reverses your last editing action. The default number of steps you can undo is 500.

4.1.8 Redo
This command applies again the editing action, which has been recently reversed by the Undo
command.

4.19 Print
This command prints the current active diagram.

4.1.10 Print Preview
This command shows the dialog with print preview for the current active diagram.
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4.1.11 Zoom
The zoom combo box allows you to zoom in or zoom out the current active diagram, when you
choose the value from the list of combo box. You can also type the custom value in the percent.

4.1.12 Grid
This command shows/hides grid and also turn on/off the snapping to the grid.

4.1.13 Show Advanced Info
This command shows/hides the advanced information about elements in the diagram. It combines
the commands Show Assigned Diagrams and Show Multiple Usage of Elements.

4.1.14 Find

The find box allows you to find the text in the entire project. Just type the text you search and press
the Enter key. The view is navigated to the first element which contains the searched text. If you
press the Enter key again, the next element with searched text is selected (if there is such element).

4.2 Layout Bar

4.2.1 Forward One
This command moves the selected element(s) one step forward in the z-order.

4.2.2 Back One
This command moves the selected element(s) one step backward in the z-order.

4.2.3 Bring to Front
This command moves the selected element(s) to front of all elements in the current active diagram.

4.2.4 Send to Back
This command moves the selected element(s) to back of all elements in the current active diagram.

4.2.5 Rows Layout
This command applies the row layout (Figure 14) to the selected elements or to the whole active
diagram, if the selection is empty.

4.2.6 Circle Layout
This command applies the circle layout (Figure 15) to the selected elements or to the whole active
diagram, if the selection is empty.

4.2.7 Cascade Layout
This command applies the cascade layout (Figure 16) to the selected elements or to the whole active
diagram, if the selection is empty.
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4.2.8 Smart Layout
This command applies the smart layout (Figure 17) to the selected elements or to the whole active
diagram, if the selection is empty.

4.3 Status Bar
The status bar is placed on the bottom of window and provides information about version number,
whether you use the registered copy and there is also the zoom control for easy zooming of content.

4.3.1 Zoom control

il

Q

Figure 21. Zoom control

4.4 Toolbox

Toolbox provides tools, which you can use to insert new elements in the diagrams. Tools are grouped
in several groups, which are displayed depending on which diagram type is edited. Common and
Drawing group is available for all diagram types.

4.5 Sidebar
The sidebar contains several tabs with various features:
* Project
e Fast Editor
* Generate
* Documentation
e Styles

* Properties

* Llayers
e TO-DO
e  Preview
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5 Sidebars

5.1 Project
Project tab contains the project tree and buttons for adding new models and diagrams.

5.1.1 Toolbar
On the top of Project tab there is placed the toolbar with buttons, which allow you to add new
models, diagrams and adjust the view on project tree.

5.1.1.1 New Model
This button appends a new model to the project. The new model will be nested in the active model,
if someone is active.

5.1.1.2 New Diagram
This button shows New Diagram dialog, where you can choose the diagram type which will be
appended to the current active model.

5.1.1.3 Refresh
This button refreshes the content of the project tree.

5.1.1.4 View
You can choose one of these values in the view combo box:

e Hierarchical View — project tree shows the hierarchy of models, diagrams and
elements.

e All Entities — this view shows all elements in the simple list. It does not display
diagrams and models.

e Diagram Types — this view shows only diagrams grouped by their type.
5.1.1.5 Filter
The project tree filter allows you to show/hide elements by these types:

* Entities

* Relations

* Groups

e Comments

5.1.1.6 Expand all
This button expands all nodes in the project tree.
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5.1.1.7 Collapse all
This button collapses all nodes in the project tree.

5.1.2 Context Menu

If you right-click on the node in the project tree, context menu will be displayed. This context menu
consists of items: Add Model, Add Diagram, Move to Model, Rename, Delete and Delete from
Project.

5.1.2.1 Add Model
This command adds new model to the project or to the selected model as a nested model.

5.1.2.2 Add Diagram
Shows the submenu with diagram types. The diagram of chosen type will be added in the selected
model.

5.1.2.3 Move to Model
Shows the submenu with models, in which you can move the selected diagram.

5.1.2.4 Rename
This command starts renaming of the selected node (project, model, diagram or element).

5.1.2.5 Delete
This command deletes the selected element from its diagram.

5.1.2.6 Delete from Project
This command deletes the selected element, diagram or model from project.

5.2 Fast Editor
Fast editor allow you to textually edit the content of the selected element.

ClassA

-NewAttributel : Integer
#NewAttribute2 : Real
~NewAttribute3 : String
+NewAttributed

-NewOperationl()

#NewOperation2(a : Integer)
~NewOperation3(a : Integer, b : String)
+NewOperation4()

Example 1. Input for fast editor
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5.3 Generate

You can choose the programming language for generated output from the combo box. The output
can be generated from whole diagram (check Whole Diagram radio button) or only from selected
elements (check Selected Elements radio button). When you click on Generate button, the generated
source code will appear in the text box below.

The supported programming languages are:

o C++
e CH
e Java

e JavaScript

« PHP
e Python
e Ruby

e SQLDDL
* VB6

e VB.NET

5.4 Documentation

Documentation tab in the sidebar consists of documentation editor. Here you can edit the
documentation of the selected element or of the diagram, when no element is selected. The
documentation text can be formatted.

5.5 Styles
Styles tab in the sidebar contains the panel with defined styles and buttons to work with them.

5.5.1 Add Style
Add Style button shows the dialog for adding a new style to the current project.

5.5.2 Set Style as Default
This button sets the style of the selected element as a default style.

5.5.3 New Style Set
This button set the new empty style set to the current project.

5.5.4 Open Style Set
This button opens the style from the chosen style set file.
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5.5.5 Save Style Set
This button saves the current style set to the chosen file.

5.5.6 Edit Style
Edit Style button shows the dialog for editing the selected style.

5.5.7 Delete Style
Delete Style button deletes the selected style.

5.5.8 Apply
Apply button applies the selected style to the selected element(s).

5.6 Properties
5.6.1 Show Dialog

This button shows the Properties dialog for the selected element.

5.6.2 Properties

Properties tab contains the fields, which allow you to edit the properties of the selected element:
e |D —custom identifier of the selected element (text value)
e Name — (text value)

* Visibility — it can be private, protected, package or public

e X — x-coordinate of the location of the selected element in the diagram (numeric
value)

e Y - y-coordinate of the location of the selected element in the diagram (numeric
value)

e Width — width of the selected element (numeric value)

¢ Height — height of the selected element (numeric value)

5.7 Layers
Layers tab provides functions, which allows you to manipulate layers.

5.7.1 Add New Layer
This button (r"k) adds a new layer, which will be placed on the top. The current active layer remains

the same one.
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5.7.2 Delete Layer
This button () deletes the active layer.

5.7.3 Show/Hide Layer

This button () shows the hidden layer or hides the displayed layer.
L

5.7.4 Merge All Layers
This button ( _ ) merges all layers to the single one.

5.7.5 Move Up
This button () moves up the active layer.

5.7.6 Move Down
This button () moves down the active layer.

5.7.7 List of Layers

The list of layers contains all layers of the current diagram ordered from the top one to the bottom
one. The first layer on Figure 22 is hidden and active, the second one is displayed. The active layer is
highlighted. The hidden layer is marked with light grey eye. If you click on a layer item, you set it as

active.
Comments .
e Default @
Figure 22. List of layers
5.8 TO-DO

TO-DO tab in the side bar allows you to add, edit and organize TO-DO items for the current project.
5.8.1 AddTO-DO
This button shows the dialog for adding the new TO-DO item.

The TO-DO item has these parts:
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e Text
e Priority — can be set to one of these values: Lowest, Low, Normal, High, Highest
e End date — date when the to-do item should be finished (it need not be filled)

e Completed — express whether the to-do item is finished

[ To Do @-‘

Text: Example of TO-DO

Priority: [Lawest v]

End date: [ 5 jna 2011 G-
[7] Completed

[ ok ][ cancel |

5.8.2 Edit TO-DO
This button shows the dialog for editing the selected TO-DO item.

5.8.3 Delete TO-DO
This button deletes the selected TO-DO item.

5.9 Preview

Diagram Preview is a sidebar panel, which displays the thumbnail of diagram and the semi-
transparent rectangle, which shows the current viewing area
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6 Diagram Editing

6.1 Inserting elements

You can insert new elements in several ways:
e Dragging from toolbox
* Drawing the element with custom bounds

* Double-clicking on free area in the diagram

6.1.1 Dragging from toolbox

1) Choose the element (for example Class) you want to insert in the diagram. Click on
button of chosen element and hold the left mouse button pressed.

2) Move cursor on the desired location, where you want to insert the new element.

3) Release the mouse button — the element will be inserted on the location of mouse
cursor with default size. You can immediately start to type the name of the inserted
element. When the name is typed, use ENTER key to confirm it.

wass Diagram
] Package
- 1 D = I":]

| Class
@ Interface
@ Enumeration
E Structure
Table

Signal

¢ Collaboration
T‘ Usage

\Hssoclatlon ,.!., ,.!., E E '::\)
. Unidir. Associa..
%, Bidir. Associati..

Figure 23. Dragging from toolbox

6.1.2 Drawing the element with custom bounds
1) Choose the element you want to insert and click on its button in the toolbox.

2) Move mouse cursor to the location in the diagram where you want to place the
element. Press the left mouse button and hold it.
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3) Drag mouse to specify the right bottom corner of the element. When you reach the
desired size of the inserted element, release the button. Inserting of the new
element is finished. You can immediately start to type the name of the inserted
element. When the name is typed, use ENTER key to confirm it.

] Package
ECT I
@ Interface

@ Enumeration

E Structure

Table

Signal

¢ Collaboration

T Usage

™\, Association

m

Figure 24. Drawing the element with custom bounds

6.1.3 Double-clicking on free area in the diagram
When you select the tool for the desired element type in the toolbox and then you double click on

the free area in the diagram, the new element with default size is inserted on the location of double-
click.

6.1.4 Tool locking

When the tool is used and a new element is inserted in the diagram, the active tool is automatically
set back as Selection tool.

If you want to insert multiple elements of the same type, you will probably want to avoid this default
behavior. You can achieve it when you lock the tool. The tool will be locked when you click on its
button twice (you need not to use double-click, the second click on the selected tool is enough).
When you lock the tool, you can add multiple elements of the same type faster and easier.

|| Class o ”

Figure 25. Example of a locked tool

6.2 Changing Bounds of Element

The bounds of an element can be changed using one of eight grip, using mouse wheel or using
command from menu.

6.2.1 Grips
When an element is selected, you can change its bounds using one of eight grips:

1) Changes location of top left corner and size
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2) Changes location of top border and height

3) Changes location of top right corner and size

4) Changes location of right border and width

5) Changes location of bottom right corner and size
6) Changes location of bottom border and height

7) Changes location of bottom left corner and size

8) Changes location of left border and height

1 ¢2

O
Class1

N
<
2R

When you press left mouse button over an element and hold it pressed while you move the mouse

A
2,
A

6.2.2 Mouse wheel

wheel, the element is inflating or deflating depending on the direction of wheel spinning.

6.3 Selecting elements
Diagram editor allows you to select one or more elements, which you can together move and resize
or perform with them any other action. There are several options how to select the elements.

6.3.1 Partial containment selection (Standard selection)
Standard selection selects all elements, which are placed within the selection bounds and also the
elements which intersect with selection border.
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Figure 26. Example of partial containment selection (elements to be selected are marked with red dots)

6.3.2 Full containment selection
If you want to select only elements which are entirely placed within the selection and no their part
intersect with the selection border, you have to select with pressed ALT key.
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Class4

Package1

Class1

Class2

Figure 27. Example of full containment selection (elements to be selected are marked with red dots)

6.3.3 Adjusting Selection
You can add more elements to the existing selection, when you hold the CTRL key and click on the
other unselected elements. If you click on a selected element with pressed CTRL key, the element will
be removed from selection.

6.3.4 Selection within container

Sometimes you want to select elements within a container (for example in package element). With
standard selection it is not possible because the element starts to move. However if you hold ALT
key, you can select also the elements within a container.
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Package1

Class1

Class2

Figure 28. Example of selection within a container (elements to be selected are marked with red dots)

6.4 Grouping of elements
The selected elements can be grouped in the group element, which behaves as another single
element. You can group elements using shortcut keys CTRL + G and ungroup using CTRL + U. You can
also use the commands from menu Arrange (Group items, Ungroup items) or commands from the
context menu (Group, Ungroup).

6.5 Diagram zooming
Software Ideas Modeler provides various ways how to zoom the current diagram:

e Zoom control — it is placed in the right bottom corner in the status bar. If you click on
magnifier icon with minus, the diagram zooms out. If you click on magnifier icon with
plus, the diagram zooms in.

e Zoom combo box — it is placed on the standard bar. You can type to it the custom
value of zoom in percent or you can select the zoom from predefined values from
the list of the combo box.

e Mouse wheel zooming — when you hold pressed CTRL key and mouse wheel, the
diagram will zoom in and out depending on the direction of wheel spinning. The view
will be stabilized to the point where the mouse cursor points.

*  Plus and Minus key — you can zoom the diagram using keyboard — plus key zooms in,

minus key zooms out.

6.6 Diagram scrolling
Diagram can be scrolled using vertical and horizontal scrollbars placed on the right side and on the
bottom side of the diagram editor window.
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If the auto-scrolling is turned on and you move the cursor outside the working area of diagram
editor, the view starts to scroll in the direction where the cursor overhangs the working area.

You can also scroll the diagram from any free area when you hold the right mouse button and move.
If you want to scroll the diagram from point where is placed some element, you have to hold the ALT
key too.

6.7 Expanding and contracting the area around the point

If you left-click on the free space in the diagram, hold pressed the mouse button and mouse wheel,
the free area around the clicked point starts to expanding or contracting depending on the direction
of wheel spinning.

6.8 Keyboard Control
Left Key — moves the selected element left by 10 pixels

Right Key — moves the selected element right by 10 pixels

Up Key — moves the selected element up by 10 pixels

Down Key — moves the selected element down by 10 pixels

Shift + Left Key — moves the selected element left by 30 pixels
Shift + Right Key — moves the selected element right by 30 pixels
Shift + Up Key — moves the selected element up by 30 pixels

Shift + Down Key — moves the selected element down by 30 pixels
TAB - select the next element in the diagram

Shift + TAB — select the previous element in the diagram

Plus —zoom in

Minus — zoom out

6.9 Context Menus
Diagram editor provides various context menus for elements.

6.9.1 Diagram
Diagram editor provides the context menu for diagram, when you right click on the free space.

6.9.1.1 Export
This command exports the current active diagram in one of supported image formats.

6.9.1.2 Show Grid

This command shows/hides the grid.
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6.9.1.3 Snap to Grid
This command turns on/off snapping to the grid.

6.9.2 Node, Entity
Diagram editor provides the context menu for nodes/entities.

6.9.2.1 Add New Diagram
This command associates a new diagram to the selected element.

6.9.2.2 Add Existing Diagram
This command associates an existing diagram to the selected element.

6.9.2.3 Group
This command creates a group of selected elements. This group will have the behavior as the single
element.

6.9.2.4 Ungroup
This command breaks the selected group(s) to the original elements.

6.9.2.5 Properties
This command shows the Properties dialog, where you can set the details of the selected element.

6.9.2.6 Documentation
This command shows the documentation of the selected element in the Properties dialog.

6.9.2.7 Delete from Diagram
This command deletes the selected element(s) from its (their) diagram.

6.9.2.8 Delete from Project
This command deletes the selected element(s) from the entire project.

6.9.3 Path, Relation
Diagram editor provides the context menu for paths/relations.

6.9.3.1 Properties
This command shows the Properties dialog, where you can set the details of the selected element.

6.9.3.2 Reverse
This command reverses the relation. It swaps the start point with the end point.
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6.9.3.3 Lock Start Point
This command locks the start point of the selected relation. The point will be locked to its relative
position on the circumference of the element, with which is connected.

6.9.3.4 Lock End Point
This command locks the end point of the selected relation. The point will be locked to its relative
position on the circumference of the element, with which is connected.

6.9.3.5 Add Point
This command adds a new point to the path of the selected relation.

6.9.3.6 Line Style
Shows the submenu with styles of the relation line. It can be one of these types:
e Straight
e Oblique
e Rectangular
* Curve
6.9.3.7 Straight

This command sets the style of line to straight. The path goes straightly from the start point to the
end point.

6.9.3.8 Oblique
This command sets the style of line to oblique. The path can be created using several lines.

6.9.3.9 Rectangular
This command sets the style of line to rectangular. The lines of the path are perpendicular to each
other.

6.9.3.10 Curve
This command sets the style of line to curve.

6.9.3.11 Delete from Diagram
This command deletes the selected relation(s) from its (their) diagram.

6.9.3.12 Delete from Project
This command deletes the selected relation(s) from the entire project.

6.10 Context Bars
Context bars displays below the selected element.
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6.10.1 Element
The context bar for element of any type contains the button for adding a comment.

Add Comment

6.10.2 Class
The context bar for class provides these buttons:

Add Attribute

e Add Operation
e Add Super Class
* Add Sub Class

e Add Interface

Add Comment
@B*EEO
Add Attnbute

6.10.3 Association
The context bar for association provides these buttons:

e Add Association Class

e Add Comment

6.10.4 State
The context bar for state provides these buttons:

* Add Region

e Add Comment

a

AddRegion
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6.10.5 Timing Frame
The context bar for timing frame provides these buttons:

e Add State Lifeline
¢ Add Value Lifeline

e Add Comment

Add State Lifeline

6.10.6 Timing Lifeline
The context bar for association provides these buttons:

e Add State
e Convert to Value Lifeline
e Convert to State Lifeline

e Add Comment

al ]
Add State
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7 Properties Dialog

7.1 General
The General tab allows you to edit the main attributes of the edited element. This tab is common for
all types of elements.

You can set there:
* Name
e ID

* Stereotypes

7.2 Style
The Style tab allows you to set the style of the edited element. You can choose among three options:

e Default style — the default style by the current style set is used.
e Style by class — you can choose one of defined style classes from the combo box.

e Custom style — you can define the custom style specific for the edited element.

7.3 Documentation
Documentation tab provides the documentation editor. You can use various formatting styles (bold,
italic, underline, strikethrough text or various font sizes) to emphasize some parts of documentation.

7.4 Tagged Values
Tagged Values tab contains the list of tagged values defined for the edited element. You can add the
new tagged values using Add button and remove the unwanted tagged values using Remove button.

7.5 Specialized Tabs
There are also numerous special tabs for individual element types. They allow you to edit the specific
attributes of the selected element.
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8 Element Browser

Element Browser allows you to view the list of all elements present in the model of the current

project. You can order the list of elements by name, ID or type.

You can rename the selected element when you double click on its name.

When you right-click on the line with an element, the context menu is shown with these items:

Open Diagram — opens the submenu with thumbnails of diagrams where the
element is used.

Rename - starts renaming of the selected element
Delete — deletes the element from the projects (from model and from all diagrams)

Properties — shows the Properties dialog for the selected element

[ Element Browser xﬁl -
Name |I[] |T]rpe |

Class1 |C[H]I1. |-::Jass |

Class2 Coo2 class

Class3 coo3 \class

Class4 \Co04 class
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9 Styles

The elements in the diagram can be styled differently. You can change the style set for the entire
project, edit this style set and also edit the style of any single element in the diagram.

9.1 Style Attributes

Software Ideas Modeler allows you to set this style attributes:

e Background type - Solid, Vertical Gradient, Horizontal Gradient, Backward Diagonal
Gradient, Forward Diagonal Gradient

e Background color
e Background color 2
* Border color
* Border width
* Name Text Format (Text Format)
o Font
o Color
o Alignment
e Stereotype Text Format (Text Format)
o Font
o Color
o Alignment
e Other Text Format (Text Format)
o Font
o Color
o Alignment
* Effects
o Gloss
o 3D gloss effect

o Shadow
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= Shadow Type - Flat, Smooth

= Offset X
= OffsetY
= Radius

= Color

9.2 Style multiple elements with the same style

If you want to easily and quickly set the same style for multiple elements, you can do it this way:

1)
2)
3)
4)
5)
6)

7)

Click on Add Style button in Style tab.

Create new style using New Style dialog.

Click on OK button - the defined style will be added into the style list.

Select elements for which you want to change the style.

Click on the created style.

Click on Apply button (instead of 5 and 6 you can double-click on the created style).

Style is applied for all selected elements.

9.3 Style Sets
The main toolbar in the Style Set Editor contains these buttons:
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New — this button set the new empty style set to the current project.
Open — this button opens the style from the chosen style set file.

Save — this button saves the current style set to the chosen file.
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Figure 30. Style Set Editor

The new styles can be added to the style set using Add button below the list of styles. The unwanted
styles can be removed using Remove button.

If you click on Add button, the New Style dialog will be shown, where you can choose whether you
want to create a general style or style for specific element.

General style can be applied to any element. It can be applied clicking on Apply button bellow the
style list in the style tab of the sidebar.

f Mew Style : ﬁ1

@ General

Shyle class name: Custom Style|

(™) For specffic elemert

| oK || canesl

Figure 31. General Style
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Style for specific element is applied automatically depending on element type and stereotype for
which it is intended. You can set the element type in the combo box of New Style dialog. If you want
to specify style for the element type regardless of the stereotype, leave the stereotype text box

blank.
rNew Style i h M1

() General

Custom Style

@ For specific element

Element type: Class - ]

Stereotype:

K || Cancel |

=]

Figure 32. Style for specific element
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10 Batch export
Batch export allows you to export the chosen diagrams to images with your custom preferences. This
features is accessible from menu File > Export > Image.

10.1 User Interface

In the left panel you choose the diagrams you want to export to images. In the bottom there are the
useful buttons Select All (select all diagrams), Invert (invert current selection) and None (deselect all
diagrams).

On the right there is tab control with two tabs Output and Content. In Output tab you can choose the
format of exported images (bitmap formats: PNG, JPG, GIF, BMP, TIFF, vector formats: SVG, WMF,
EMF and image inside PDF document), the type of file naming and output directory, where generated
files will be saved.

10.2 Output
The output of export can be adjusted using several settings. Diagrams can be exported to various
image formats.

The supported image formats are:

< PNG
. JPG

« GIF

« BMP
« TIFF
- WMF
« EMF
« SVG

* Image inserted in PDF

10.3 File Naming
There are two options how to name the files with generated images. The first option is to use for files
the same name as the diagram.

Setting Result

Original Example Class Diagram
LowerCase example class diagram
UpperCase EXAMPLE CLASS DIAGRAM
CamelCase exampleClassDiagram
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PascalCase ExampleClassDiagram

Underscored Example_class_diagram

Hyphened Example-class-diagram

The second option is to define the custom pattern for file naming. The default pattern is:
<ModelName>_Diagram<Index>_<DiagramName>

The tags you can use in the custom name pattern:

Tag Meaning

<ModelName> The name of parent model of processed diagram.
<Index> The index of processed diagram in sequence.
<DiagramName> The name of processed diagram.

<Uid> Internal ID of diagram.

10.4 Content
The attributes of generated images can be adjusted in the Content tab. There are settings for layer
handling, size and background style of images.

10.4.1 Layer Options

Export Only Active Layer — exports only active layer for each diagram, other layers will be omitted.
Export Hidden Layers — exports all layers including hidden layers.

10.4.2 Sizing

Absolute size — all exported images will have the same absolute size.

Relative size — width and height is defined as percentage of the original diagram size.

10.4.3 Background
The background of exported diagrams can be transparent or a color gradient.
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Batch Export

Diagrams

=-[¥] Project (Project)
=-[¥] Maode! 1 {Model)

-[¥] UseCaseDiagram1 {Diagram)
-] EntityRelationship Diagram1 (Diaar
-[¥]ClassDiagram1 ({Diagram)
--|¥]ClassDiagram2 (Diagram)
--[¥]ClassDiagram 3 (Diagram)
--[¥]ClassDiagram4 (Diagram)
--[¥|ClassDiagram® (Diagram)
-[¥]ClassDiagramb (Diagram)
--[¥|ClassDiagram 7 (Diagram)
--[¥]ClassDiagram & (Diagram)
-[¥] CommunicationDiagram 1 {Diagran
--[¥] StateMachineDiagram1 (Diagram)
--[¥] TimingDiagram1 {Diagram)
|| ClassDiagram® (Diagram)

1 |

Format

Image Format:

Files

File names:
i@ Diagram name:
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Output directony:

PNG

Original

)

<ModelMame>_Diagram=Index:_«Di

C:UsershDusanDocuments® D

| SelectAl || iwet || None

J [ Coned
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11 Print

The diagrams can be printed in the different ways. You can print the current diagram (button Print on
the standard bar or menu Diagram/Print).

If you want to print multiple diagrams at once, click on menu File/Print. The Print dialog will be
displayed, where you can define, which diagrams will be printed. The Settings tab provides advanced
options for printing. The print will start after clicking the Print button.

=-[¥] Project (Project)

=[] Model 1 (Model)
.[¥] UseCaseDiagram1 (Diagram)
..[¥] EntityRelationship Diagram 1 (Diag
.[¥]ClassDiagram 1 (Diagram)
..[¥]ClassDiagram2 (Diagram)
.[¥]ClassDiagram3 (Diagram)
.[¥]|ClassDiagram4 (Diagram)
.[¥]|ClassDiagram5 (Diagram)
[V ClassDiagram (Diagram)
.[¥]ClassDiagram7 (Diagram)
[V ClassDiagram® (Diagram)
-[¥] CommunicationDiagram 1 {Diagra
.[¥] StateMachineDiagram 1 (Diagram,
-[¥] TimingDiagram1 {Diagram})
-..[¥|ClassDiagram3 (Diagram)

11.1 Print one diagram on multiple pages
If you want to print a diagram on multiple pages, follow these steps:

1) Click on menu item File>Print

2) Switch to Settings tab

3) Choose Multiple pages in group box 'Pages Per Diagram'

4) Set the number of pages in horizontal and vertical direction

5) Click on Print (in top toolbar)
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12 Documentation Generation
Document Generation tool allows you to generate the documentation for the current project. You
can choose one of the supported formatted for the output document.

The supported formats are:
 PDF
e RTF

Documentation generator needs some additional data before it starts the generation of
documentation:

* Document title

e Document subtitle
e Company

e Authors

You have to choose the output file for the documentation. You can either type its full name with path
to Output file text box or you can select the file using Save File dialog, which is accessible from ellipsis
button.

r |
Generate Documentation l&]
General

Farmat
@ FDF
) RTF

Texts

Document title:

Document subtitle:
Company:
Authors:

Qutput file: E

Generate H Cancel

Figure 34. Document Generation dialog
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13 Source Code Generation

Software Ideas Modeler provides the tool for generation of source code. It launches from menu

Tools/Generate Source Code.

In the source code generation dialog, you can select which elements want to include to source code

generation.

You have to choose the language for source code generation and the output directory on the General

tab before you click on Generate button.

-

Source Code Generation

ot

=-[¥] Project (Project)
=-[¥] Model 1 (Model)
= [#]ClassDiagram 1 {Diagram)
7] Package1 (Package)
[¥]Class2 (Class)
“..[¥]Class1 (Class)

General | Imports |

Language:

Output directony:

[Ja\raScripi

C:A\Usersh\Dusan“Documents’.Test

[ Generate ][ Cancel
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14 Reverse Engineering

14.1 .NET Framework

Software Ideas Modeler allows you to import classes from your compiled .NET assemblies. If you
want to create the new diagrams based on your existing code, firstly you have to create the new
Software Ideas Modeler project or open the existing one. Then follow this instruction:

1)
2)
3)
4)
5)
6)

7)

Click on menu item Tools/Reverse Engineering/.NET Framework.
In displayed dialog click on button Add.

Select the file (exe or dll) you want to import.

Click on Next button.

Choose namespaces you want to import.

Click on Import button.

Program generates class and package diagrams from your existing code.

14.2 Database

There is also a tool for import of a database model. It is accessible from menu Tools/Reverse
Engineering/Database. You can insert directly the connection string or edit it using a dialog, which
shows, when you click on Ellipsis button.

The list of tables will be filled when you click on Load Tables button. You can choose which tables
from this list you want to import in your project.

77



|

Connection string: Data Source=5qglServer; Intial Catalog=Database; Integrated Secur

Tables

Attachments - Select Al
skt |

o
Department Persons
£ Do
Department TicketCategories

Global Settings

Images

Persons

Priorities i

[l I g PR N —p—

Figure 36. Import Database dialog

Data source: |MS SQL Server

Server name:

Authentication
Authentication type: | Window Authentication

Lser name: |

Password: |

Database name:

Figure 37. Database Selection - connection string editor



15 Task management

Software Ideas Modeler provides a simple integrated task management tool.

15.1 Add Task

This button shows the dialog (Figure 38), where you can define the new task and clicking on OK
button to add this new task to the current project.

15.2 Edit Task

This button shows the dialog (Figure 38), where you can change attributes of the selected task. Your
changes will be applied after clicking OK button.

15.3 Delete Task

This button deletes the selected task from the current project.

15.4 Assign Person

This button shows the menu with persons defined in the current project. You can choose which
persons shall be assigned to the selected task

79



80

Task

Task 1
1D 1
Start Date: 5 juna 2011 E-
End Date: . jna 2011 E~
Priority: | Normal -
Fhase:
Progress: 0 - i
Description:
ok ][ Conce
Figure 38. Task editor




16 Lists

Software Ideas Modeler allows you to edit its default lists. There are defined lists of:
e Stereotypes
e Types

e Default names and IDs

16.1 Stereotypes

You can add or remove default predefined stereotypes for each element type. The type of element,
for which you want to edit the list of stereotypes, can be chosen from the Element type combo box.
The list of all defined stereotypes for this type will be displayed in the left list.

The General tab allows you to edit the name and description of the stereotype selected in the list.
The Applies To tab allows you to set the elements for which the current stereotype can be used (this
tab contains the checkbox list where you can edit, which element types support this stereotype).

i b |
Stereotypes ﬁ

Element type: [Dass ']
{Genersl || Applies To |

bounday | [

control Mame: aLndliary
delegate

enum Description:
focus
implementationClass
interface

metaclass
powertype
realization
specification

struct

thread

type

wLtility

| Add || Remove 0K || Cancel

Figure 39. Editor for Stereotypes
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16.2 Types

Types are organized in groups called type sets. Each type set contains the list of types from some
programming language or from a specific domain.

If you want to create a new type set, click on New Type Set button in the top toolbar.

If you want to import an existing type set from file, click on Import Type Set button in the top
toolbar.

You can edit the selected type set clicking on Edit button. Type Set editor will be launched.

r-T;l,-'pus_'f. @1

Mew Type Set ™ Import Type Set

Type Sets | Custom Types

[ G+ Edit
[ c#

[ Java
[F] MssaL
[] Postgre
[ Python
[ Ruby
ML
[ VB.NET

OK || Cancel

Figure 40. Editor for Type Sets

16.3 Default Names and IDs

When you create the new element, it has some default name which ends with number and some
default ID. Generation of this attributes can be adjusted by your preferences using Default Names
and IDs editor.

You can browse element types grouped by diagram types, for which are defined. The diagram type
can be chosen in the bottom Diagram type combo box. After selecting the element type in the left
list, you can edit its patterns for default new name and ID.

The default ID pattern can contain the alphanumeric characters and the hash symbol (#). The hash
symbol is used as placeholder for digits.
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Diagram type: [ LML Activity Diagram b ]

Element type
.Bu:;gznﬁnal e Default name: Activity
Flow Final

Forl/Join Default 1D: AfHE
Initial Node

Imtemuptible Activity Region
CObject

Accept Time Event Action
Transition

Swimlane

Signal Send

Signal Receipt

Figure 41. Editor for Default Names and IDs
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17 Options

17.1 General
17.1.1 Show Start Page
When the option Show Start Page is turned on, start page will be displayed on application start.
17.1.2 Recent Projects
* Items in menu — sets the number of displayed recent projects in the menu.
* Items on start page — sets the number of displayed recent projects on the start page.
* Clear Recent Projects list — irreversibly clears the list of recent projects.
17.1.3 Toolbars
e Standard
* Toolbox
» Status bar
* Side bar
* Llayout

17.1.4 Shortcut keys
e Don’t use shortcut keys with CTRL-ALT

17.2 Diagram Editor

17.2.1 General
e Auto scrolling —if it is turned on, program automatically scrolls the editor area, when
you reach the border of the displayed area.

* Display relations always on top —if it is turned on, relations are displayed always on
top, independently from their real z-index.

17.2.2 Grid
e Snap to grid — if it is turned on, elements are snapping to the grid defined by
horizontal and vertical spacing.

e Show grid —if it is turned on, grid is displayed.
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e Horizontal spacing — defines the horizontal space between two points of grid
(difference between x-coordinates of two nearest points).

e Vertical spacing — defines the vertical space between two points of grid (difference

between y-coordinates of two nearest points)

17.2.3 Design
e Background color — first color of the gradient on the background of the diagram
editor.

e Background color 2 — second color of the gradient on the background of the diagram

editor.

17.2.4 Default Settings for Elements
e Attribute Visibility — defines the default visibility, which will be used for newly
created attributes.

e Operation Visibility — defines the default visibility, which will be used for newly
created operations.

e Show Nullability — defines the default showing of nullability, which will be used for
newly created ERD entities.

17.3 Project Tree

17.3.1 Initial State
* Fully Expanded — after project loading the project tree will have expanded all nodes

e Expanded Project — after project loading the project node in the project tree will be
expanded, other nodes will be collapsed

e Expanded Models — after project loading the project node and model nodes in the
project tree will be expanded, other nodes will be collapsed

* Collapsed —all nodes in the project tree will be collapsed

17.4 Update

e Turn off — auto update and also update notifying will be turned off

* Notify new version — program will notify the user when new version is available for
download

* Download automatically new full setup file and install (Windows only) — program
automatically download the setup file and offer its installation, when new version is
available
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Fast auto update — download and apply only changes
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